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Extrae/Paraver

 Developed by Barcelona Supercomputing Center
e Extrae for instrumentation

e Paraver for visualization and performance analysis
e Installed version on Summit: v3.7.1

« Module: extrae

« Web site: hitps://tools.bsc.es/extrae
hitps://tools.bsc.es/paraver
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https://tools.bsc.es/extrae
https://tools.bsc.es/paraver

Capability Matrix - Extrae
Copobity L Poties  ccngNossimitclors

MPI, MPI-IO

OpenMP CPU Yes Yes Only GNU

OpenMP GPU Yes Yes Only with GNU compiler, no OpenACC
OpenACC No No

CUDA Yes Yes Not advanced

POSIX 1/O (X X

POSIX threads Yes Yes

Memory — app-level Yes Yes Need to use dynamic allocation
Memory — func-level Yes Yes Need to use dynamic allocation
Hotspot Detection Yes Yes

Variance Detection Yes Yes

Hardware Counters Yes Yes
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Compilation

« Extrae is a bit more complicate to start using it compared to many
other tools

* We can have dynamic or static compilation
— For static, it is required to recompile

— For dynamic is required to compile with -g, it works even without -g but less
information will be instrumented:
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How does Extrae work?e

« Symbol substitution through LD_PRELOAD

— We need to use specific libraries based on programming language/model

e Dynamic instrumentation (based on Dyninst)

o Static link
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Trace Generation Workflow

1) Compile & link with debug info (-g)

2) Don't strip the binary

Application
Process

——)
—

C_____ 2
prv

.pcf
.row

Paraver
Dimemas
Clustering
Tracking

Folding

!

Instrumentation

!

Analysis



Library Selection

« Choose alibrary depending on the application type
« The suffix “f" is for Fortran codes

Library Serial MPI OpenMP pthread CUDA
libseqtrace v

libmpitrace][f]’ v

libomptrace 4

libpttrace v
libcudatrace 4
libompitrace]f] v v

libptmpitrace][f] v v
libcudampitracelf] ' v v

1 include suffix “f’ for Fortran codes

%OAK RIDGE

National Laboratory




Trace visualization/analysis

+ trace manipulation

Timelines
Goal = Flexibility
No semantics
Programmable
2/3D tables
(Statistics)

Comparative analyses
Multiple traces
Synchronize scales
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Extrae XML configuration - MPI

<counters
<cpu
<set = =
PAPI_TOT_INS,PAPI_TOT_CYC,PAPI_FP_OPS
</set>
<set = = ="Q">
PAPI_TOT_INS,PAPI_TOT_CYC,PAPI_SR_INS,PAPI_FP_INS
<openmp - <sampling = = >PAPI_TOT_CYC</sampling>

<locks = /> </set>
<taskloop </cpu>

<counters = <network
</openmp> <resource-usage

<mpi
<counters
</mpi>

<memory-usage
<cuda </counters>

<pthread <buffer >
<locks <size >5000000</s1ze>
<counters .
<circular

</pthread>
</buffer>
<callers

<mpi >1-3</mpi>
<sampling = >1-5</sampling> <bursts
<dynamic-memory = >1-3</dynamic-memory> <threshold >500u</thresholds
<input-output = >1-3</input-output> <mpi-statistics
<syscall >1-3</syscall> </bursts>
</callers>
<sampling

<dynamic-memory
<alloc
<free
</dynamic-memory>
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Execution and Merging

e jsrun-n64 -r8-a1-c1 .ftrace.sh ./miniWeather_mpi

e trace.sh:

#!/bin/bash

export EXTRAE_HOME=/sw/summit/extrae/3.7.1/rhel7.5 _gnu6.4.0
export EXTRAE_CONFIG_FILE=/full_path/extrae.xml

export LD_PRELOAD=${EXTRAE_HOMEY}/lib/libmpitrace.so:3LD_PRELOAD
ﬁ*

e jsrun-n 64 -r 8 -a 1 -c 1 mpimpi2prv -f TRACE.mpits -e miniWeather_mpi
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After the execution with merging

e Afolder set-X where X is number 0,1, etc. with the traces, one folder
for every 256 MPI processes

* Files based on the merging output, *.prv, *.pcf, *.row, the first one is
the merged trace and the rest information about the trace and the
events.

 Now you need to visualize the trace for performance analysis.

* We use the tool Paraver, it is available for Linux, Mac, Windows and
already pre-compiled (htips://tools.bsc.es/downloads), quite difficult
to be built on Power processor. Available on Rhea or your computer.
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Paraver on Rheag

% ssh =Y username@rhea.ccs.ornl.gov
% module load paraver
% wxparaver

Location for configuration files: /sw/rhea/paraver/cfgs/
Is /sw/rheal/paraver/cfgs/

burst mode clustering counters PAP|I CUDA folding General Java mpi
OmpSs OpenCL OpenMP pthread sampling+folding scripts
software countersspectral uninstall.sh
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Paraver — Load frace

000 [X| Paraver 000 I\ Paraver
File Hints Help ﬁ Hints  Help
Workspaces Previous Traces »

Unload Traces...
‘ None nioad Irace:

Load Configuration...

Window browser

Previous Configurations 4
All Traces - N
Save Configuration...

Load Session... ctri+L
Save Session... ctrl+s
Preferences...
Load trace .
Quit ctrl+Q
—
Files & Window Properties Files & Window Properties
== =)=
» [ Jrun » Clrun
» [Ishin » [ Ishin
lsrv [ srv
P [sw b [Clsw
b [sys P [sys
P [tmp » T tmp
¥ [ jusr » [ Jusr
¥ [var I b [Clvar
Paraver files v Paraver files -
v Automatic Redraw +| Automatic Redraw Force Redraw
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Paraver - Filter tfrace

Name ¥  Size Modified
[Told 12:31
[ set0 12:01

B miniweather_mpi.prv 3.3GB 12:09 ®0O0 X! Reduce trace size

@ The size (3267 MB) of the trace
Reduce trace size

/gpfs/alpine/gen110/scratchjgmarkomajextrae/miniweatherjc/
miniWeather_mpi.prv

—

exceeds the maximum loadable defined in Preferences.

Would you like to cut/ffilter the trace?

‘ No H Cancel ‘ Yes

Click Yes

‘ Paraver trace (*.prvi*.prv.gz) «

‘ Cancel Open
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Paraver -

Click Browse and load the filter.xml file

® 00
Traces

Input

Output

Cut/Filter Parameters

Configuration file

[X| Cut & Filter

miniWeather_mpi.prv

Filter trace

Browse

miniWeather_mpi.filterl.prv

Browse

[+ Load the processed trace
(] Run application with the processed trace

filter.xml

/

Browse

Execution chain

1.- Filter

[ 2.-Cutter
[ 3.- Software Counters

Cutter | Filter | Software Counters

Discard Records

Keep states

[ idle

[+ Running
| Notcreated
Waiting a message
Bloking Send
Thd. Synchr.

Events

Keep communications

Minimum size
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[ ] state (¥4 Event [_| Communication

l Selectall

Unselect all

Min. burst time | 50000

Add

Delete

Discard

Save...

ke
4

Cutter | Filter | Software Counters

Discard Records
[] state (¥ Event [_|] Communication

Keep states
DIULKREU

Inmediate Send

Inmediate Receive

/O

[ Group Communication
[ Tracing Disabled

[ _Others

Fuantec

Z Bytes

Cancel Apply

Select all

Unselect all

Min. burst time | 50000




Paraver — Visualize frace

Click Browse and load the filter.xml file

@ |\ Paraver

. @ [ ] [%| New window #4 @ miniWeather_mpi.filterl.prv
File Hints Help
: (= A 4w
Waorkspaces
None
Window browser
miniWeather_mpi.filterl.prv -
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Paraver — Investigating frace

X New window #4 @ miniWeather_mpi.filter1.prv

Pixel Size »

R
H Ctrl+C !
| Remove the communication links
Fit Time Scale
1 | | | Fit Semantic Scale 4 | | !
Fit Objects . ol
Select Objects... Il |
Paint As » [ EventFlags |
Drawmode » Il | N

Object Labels »

Object Axis g -

@ [ ] %| New window #4 @ miniWeather_mpi.filterl.prv
.

e BIEEIE
B I
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Zoom, left click with mouse and
select area moving the cursor
horizontally fowards right and
decide which part we want to
study

] [ ] X| New window #4 @ miniWeather_mpi.filterl.prv
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Paraver — Computation configuration file

+ We load h_comp_time.cfg, File -> Load configuration Click on Open Control Window

m Hints Help \ Useful Duration @ miniWeather_mpi.filter1.prv
c B Q@ (mw|om
Load Trace...

Previous Traces >
Unload Traces...

Load Configuration...

Previous Configurations >
Load Session... 8L
Save Session... #S
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Paraver — Computation configuration file

« We load h_comp_time.cfg, File -> Load configuration

Yo

Useful Duration @ miniweather_mpi.filter1.prv

THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD

THREAD
THREAD
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THREAD 1.1
THREAD
THREAD
THREAD
oom THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD

THREAD
THREAD

We can see some
iterations

THREAD
THREAD
THREAD
THREAD

THREAD

Useful Duration @ miniWeather_mpi.filter1.prv

Useful Duration @ miniWeather_mpi.filter1.prv
1.1.1



Paraver — Extract part of the original trace

L 3gectforinput the original frace
1 races +  Select cut for the execution chain
° SeleCT Filter Trace Tmput miniWeather, mplpry —_— +  Trace options: Use original time to be able
- to compare between traces and remove last

Output ] Browse S-I-O fe
x Paraver

Click Select region and mark the area to cut from the original frace
D@ E X |4

[miniweather_mpi.chop.prv

& Load the processed trace L]
"] Run application with the processed trace .

Cut/Filter Parameters

Click Apply, the tfrace will be created and loaded

/home/gmarkomanolis/Downloads/miniweather_n 2

Configuration file Browse

Execution chain

Cutter | Filter | Software Counters

—I= Useful Duration @ 1.-Cutter T35S
—I[= Useful Duration 2.-Filter 1 Save...
> 3.-Software Counters 1 Select Region... All Window All Trace

Cutter | Filter | Software Counters Trace Options

& Use original time ] Remove first state

Trace Limits
& [Remove last state
Cut by time Begin B
® Y g "] Keep boundary events
Cut by time % End
Output Trace
Tasks Maximum trace size [ - MB
Select Region... Allwindow All Trace

Cancel Apply
Trace Options

[ Use original time ] Remove first state

| Don't break states | Remove last state

Cancel Apply

x Paraver

43 & @

Window browser

Useful Duration @ miniWeather_mpi.filter1.prv

/home/gmarkomanolis/Downloads/miniweather_mpi.chop1.prv =
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Paraver — MPI Profile

« Select Hints -> MPI -> MPI Profile

MPI call profile @ miniweather_mpi.chop1.prv

e B o Q8 mlum

MPI call profile @ miniWeather_mpi.chop1.prv
€l QR (minjEmn)z %

LN VTR MPI_Allreduce | MPI_Comm_rank | MPI_Comm_dup |

THREAD 1.1.1
[ JoNe] I\ Paraver THREAD 1.2.1
File Hints Help HRESTIEN S
- —_— THREAD 1.4.1
N | MPI » MPI profile THREAD 1.5.1
T callers » Point 2 point connectivity pattern THREADI-6 1
B P e > THREAD 1.7.1
MPI- HWC » Histogram of durations per MPI call - ) | TUREAD 1.8.1
=0 flush » Histogram of message sizes per call IRHRES TS
Windo.. . _.__. THREAD 1.10.1
miniWeather_mpi.chop2.prv -

THREAD 1.18.1

MPI_Isend

Scroll down

Click Hints -> MPI profile -> Histogram TTIEL -5
oom :

The average under the column
Qutside MPI represents the parallel
efficiency, the value Avg/Max is the
load balance and the Max is the
communication efficiency L —

Average 98.32% 011% 0.11% 025%  0.02% 0.63% 0.00%
Maximum 98.45%  0.12% 0.12% 030%  0.02% 1.06% 0.00% 0.01%
Minimum 98.28% 0.11%  0.11% 012%  0.01% 0.40% 0.00% 0.01%
StDev 007%  0.00% 0.00% 007%  0.00% 0.16% 0.00% 0.00%
Avg/Max 1.00 0.96 0.97 0.83 075 0.59 0.96 0.90
[mPI_Isend
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File Hints Help

‘o mE X 4w
Workspaces

MPI+callers+HWC+flush
Window browser

miniWeather_mpi.chop2.prv

Paraver - Analyzing the trace - MPI Profile

—1= MPI call
o

—|= MPI call 2DZoom range [4.4]
—|= MPI call 2DZoom range [4,4]
—I= MPI call

\—:[ MPI call profile

ﬁl&Windnw Properties

=) /
Delta 1 l

Bl Statistics
Type Communication
Statistic Maximum bytes sent

Minimum Gradien 12800
Maximum Gradier 12800
Data
H a0

(¥ Automatic Redraw

Force Redraw

€ B33 Q& W H e I%N I %

THREAD 1.1.1 THREAD 1.2.1 THREAD 1.3.1 THREAD 1.4.1 THREAD 1.5.1 THREAD 1.6.1 THREAD 1.7.1 THREAD 1.8.1 THREAD 1

THREAD 1.1.1 |THREAD 1.2.1 QI INF D RSCHE THREAD 1.4.1 |THREAD 1.5.1 [ THREAD 1.6.1

THREAD 1.8.1 gL {0

THREAD 1.1.1 - 12800 - - - - - _

THREAD 1.2.1
THREAD 1.3.1 - . 12,800
THREAD 1.4.1 - - - 12800
THREAD 1.5.1 - - - 12800
THREAD 1.6.1 - - - - 12800

THREAD 1.7.1 -

THREAD 1.10.1 - - - - - : ,
THREAD 1.11.1 - - - - - - } _
THREAD 1.12.1 - - - - - . : ;
THREAD 1.13.1| - - - - . - .
THREAD 1.14.1 - - - - - } ,
THREAD 1.15.1 - - - - - : ,
THRFAD 1 18 1/ - _

Outside MPI

Select Window properties ->
Communication for Type and
Maximum bytes sent for Statfistic.
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Paraver - Computation

Load the 2dh_usedulduration.cfg for a histogram of the duration for the computation regions
A lot of areas are not constituted by vertical lines which shows load imbalance.

We explore in the next slide what is inside the red circle _

We select Open Filtered Window and we zoom in the area of red circle

2DH usefullduration correlated with @ miniweather_mpi.chop1.prv

= 2 = =
. =
= = = =
— : = —
. === % =
i ¥ i ¥ !.-' -
R == = - =
1 e
== -~ =
== = =
..... ' | 1 | E |
== - -
== = -
L =
. === = =
| i " .
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Paraver - Computation

« We zoom in the first area, we compare with the MPI calls and the 2dp_line_call.cfg
* Only the processes 2-8 execute this part and seems that is not instrumented, thus, It
could be from an external library

@ @ useful Duration 2DZoom range [334.35,445.171) @ miniWeather_mpi.chop1.prv

THREAD 1.2.1

THREAD 1.3.1

THREAD 1.4.1

THREAD 1.5.1

THREAD 1.6.1

THREAD 1.7.1

THREAD 1.8.1

14,613,791 us - 14,613,791 us
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Paraver Useful Instructions

@ ® useful instructions 2DZoom range [6.66458e+06,7.13533e+06) @ miniwWeather_mpi.chop1.prv

THREAD
THREAD
THREAD
THREAD

THREAD

» Load the 2dh_useful _instructions.cfgs

THREAD
THREAD

THREAD

@ © 2dh useful i¢ structions @ miniWeather_mpi.chop1.prv

W H

THREAD

THREAD

THREAD

THREAD

THREAD

THREAD

@ @ MPI caller line @ miniWeather_mpi.chop1.prv
— T

P e et el e e et e e el e e e el e e o

[2,355,420.55..2,391,631.99)

I6.839,175 - 6,890,483
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Paraver — Extract part from the original frace

Input miniWeather_mpi.prv Browse
X Paraver B -mpLp

File Hints He|p Output miniWeather_mpi.chop2.prv Browse

+ Load the processed trace
Run ication with the pr d trace

O0RE x| |4

worspaces N T e After we click “Select Region...”

— then select the area from the
S already opened filtered trace

|
|

Window browser

_ 3.-Software Counters

Bk

miniWeather_mpi.filterl.prv -

|- New window #4 Cutter | Filter | Software Counters
T i

Trace Limits

(o) Cut by time Begin

() Cut by time % End

Tasks /

Select Region... All Window All Trace

Trace Options

] Use original time [_] Remove first state

| Don't break states [_] Remove last state

U
[_] Keep boundary events

Output Trace
Maximum trace size

0 “ImB

Cancel Apply

~
| &
=
Z
5
o
)
H3
3
E
2]
3
EX
=
©
2
=D
@
_
3
g
=
2

I
[
|
.
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Paraver — Profile per calling line

We load the 2dp_line_call.cfg, we select open control window and synchronize the new
window

[ ] [ ] |X| MPI call profile per calling line @ miniWeather_mpi.chop2.prv

—— [ B 3D L & H H (I E %

THREAD 1.64.1 371 (miniWeat.._ mpi.cpp) = 80,087.29 us

%OAK RIDGE

National Laboratory




Paraver — Late receivers

We load the late_receivers.cfg and the 2dp_line_call.cfg

MPI recv call cost BW @ miniWeather_mpi.chop2.prv

154,374 ue 388 (miniWeat.. mpi.cpp;

MPI caller line @ miniWeather_m

MPI caller line @ miniWeather_mpi.chop2.prv

Default
Clone

Undo Zoom
o Zoom

Fit Time Scale

Fit Semantic Scale

Fit Objects

Select Objects...

View

Paint As
Drawmode
Pixel Size
Object Labels
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Paraver — Late senders

We load the receiver_from_late_sender.cfg and the 2dp_line_call.cfg

[ ) [ ] Sender was late @ miniWeather_mpi.chop2.prv

(miniWeat.._mpi.cpp)
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MiniWeather MPI+OpenMP

e jsrun-n64 -r8-a1-c2 .trace_openmp.sh ./miniWeather_mpi_openmp

* Trace _opnemp.sh:
#!/bin/bash

export EXTRAE HOME=/sw/summit/extrae/3.7.1/rhel7.5 gnu6.4.0
export EXTRAE CONFIG_FILE=/gpfs/alpine/.../c/extrae _openmp.xml

export
LDp_PRELOAD=${EXTRAE_HOME}/Iib/libompitrace.so:$LD_PRELOAD
## Run the desired program

$*

e jsrun-n64 -r8-a1-c2 mpimpi2prv -f TRACE.mpits -e
/miniWeather_mpi_openmp

%OAK RIDGE
National Laboratory




Parallel Loops

e Create a new chop file as described before
* Load the parallel loops.cfg and zoom

® 0 %/ Parallel loops @ miniWeather_mpi_openm
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Parallel Loops

e Create a new chop file as described before
* Load the parallel loops.cfg and zoom

0@

%| Parallel loops @ miniWeather_mpi_openmp.chopl.prv

geOAK RIDGE
Nat:

ional Laboratory




Load Balance

* Load OpenMP/analysis/load_balance.cfg
* Load the parallel loops.cfg and zoom

-~

Load Balance (microscopic level) @ miniweather_mpi_openmp.chop1.prv

e B Q@ (m| = 5| m

Parallel functions span 2DZoom range [6,6] @ miniWeather_mpi_openmp.chop1.prv

TASK 1.18 set_halo_values_x =0.93
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Load Balance

* Load OpenMP/analysis/load_balance.cfg

Parallel functions span 2DZoom range [6,6] @ miniWeather_mpi_openmp.chop1.prv

J] Scheduling and Fork/Join
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Load Balance

* Load OpenMP/views/parallel functions useful.cfg and zoom

THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD

THREAD

THREAD
THREAD

HREAD

HREAD

HREAD

HREAD

HREAD

HREAD

HREAD

HREAD

HREAD
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%

]

File Hints Help
0 MPI
Worksj OpenMP
MPI- callers

HWC
Windo;
flush

4

4

4

% | Paraver

1WC+flush

Flushing trace buffer

miniv';uu|\_|_||||_/|_upg|||n|.J.\_.||uP_|_.p| W
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Ctrl + Zoom

Paraver - Flush

006

THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD

THREAD
THREAD

MPI caller @ miniweather_mpi_openmp.chop1.prv

06
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD
THREAD

THREAD

MPI caller @ miniweather_mpi_openmp.chop1.prv

Jj ncmpiio_. .lalias.1 13,622,933 us

[ nempiio_..lalias.1



Paraver — Chop bigger area

Activate communication lines
Right Click -> View -> Communication
lines

Because of I/O rank O, it delays
to post the MPI_Irecv and
MPI_ISend

Ctrl + Zoom
on top
processes
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